
 
 

Luminis Content Management System 
Abbreviate User guide 

 
 
PREREQUISITES FOR USING SITE STUDIO 
 
WEB ADDRESS FOR SITE STUDIO 
The URL for FAU’s LCMS Site Studio is: http://fauss.fau.edu/lcms  
 
 
 
SUPPORTED BROWSERS 
To access Site Studio, you must use one of the following supported browsers: 
Browser  Operating System  Versions 
Netscape   Windows   7.2  
MS Internet Explorer  Windows   6.0 
MS Internet Explorer  Macintosh*   5.2.3 
         * To use the Site Studio on a Macintosh, you must be running OS X version 10.2 or later. 
 
 
JAVA RUNTIME ENVIRONMENT NEEDED 
If you are working on a Windows operating system you must have version 1.4.2 or later of Sun’s 
Java Runtime Environment (JRE) Java plugin installed on your computer and enabled for your 
browser to use the automatic content creation tools provided through Site Studio.  
 
You can verify if you have the pluggin by going to: 
http://java.sun.com/getjava  
 
If you see the java.com showcase animated in the in the middle of the page, then you have 
software successfully installed.  
 
If not, you can download the Java Runtime Environment at: 
http://java.com/en/download/manual.jsp 
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LOGGING IN TO SITE STUDIO 
 
 
 From the SCT Site Studio Login menu, enter your login credentials. 

The Login Name and Password should match your MyFAU login. 
 
 Select the ‘Site Studio’ as the appropriate Entry Point. 

 
 Click Login. 

 
 If not already selected, click the My Sites tab. This will lists all the sites for which a user 

has access to. 
The My Sites tab lists all the sites for which a user has access. It is important to note that there 
is no hierarchy to this list. 
 

 Click on the Site you which to view. 
Once the user has clicked into a site, the application provides a list of Webviews that it 
contains, the items that have been placed in its Shared Folder, which is content that can be 
used across many publishing configurations (e.g. Public Website, Intranet site, Luminis 
channel publishing, etc.), and—if the user is a Site Manager, Template Developer, or System 
Administrator—a list of subsites. 
 

 From the list of Webviews displayed for the site, click the Webview that contains the 
content you want to view. 
Note: All content that is published for a site is maintained in a Webview. A site may have 
more than one Webview, depending on the type of content that it maintains, where that 
content is being published, and the intended audiences for the content. Basically, a Webview 
is a folder where the Webpages, images, and supporting files are stored. Within the Webview, 
subfolders may be created to more logically store content elements. For example, a Webview 
may have subfolders dedicated to images, PDFs, and Word documents, all of which are used 
as supporting elements for its Webpages. 
 

 To view a content file, click the filename or the View option next to its name.  
If the content that you are viewing is a Webpage, you see it framed within the Site Studio 
application 
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CREATING AND MODIFYING CONTENT 
 
CREATING A NEW PAGE 
 
 If you have not already done so, log in to Site Studio 

 
 From the My Sites tab click open the site where you want to create a new page. 

 
 Click open the Webview where you want to create the new page. 

 
 From the Folder Actions menu, select the New Document option. 

 
You see the New SCT Webpage screen opened to the Page Info tab: 
 

 
 
 

 In the Name field, enter a name for your Webpage. 
The name cannot contain spaces and can include alphabetic and numeric characters (e.g 
abc123), a dash ( - ), an underscore ( _ ), or a period ( . ). No other characters can be used. Do 
not place an extension (such as .html, .html, .xml, etc) 
 

 If necessary, enter a title, subject or any keywords that you want the page to have. 
These elements are optional and used for document description and searching. If you do not 
supply any when the page is created, you can add them at a later date if necessary. 
 

  If necessary, set an Effective and Expiration Date for the page. 
The Effective Date stipulates when the page can be included on an active Website. The 
Expiration Date stipulates when the page will be removed. If you do not set an Effective or 
Expiration Date, the page will use the default expiration period defined for your site. 
 

 Click Next. 
You see the Page Layout tab that provides a list of all layouts available for you to base a page 
off. 
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 Check the layout that you want to use for your page. 
 

 Click Finish & Edit to create the page and begin editing right away. To create the page 
and save it to the Webview for later use, click OK.  

 
The page will be saved to the site’s Webview. You can access the page and edit it to begin adding 
content to it. To begin adding content to the page immediately, you can click the Finish and Edit” 
button. The page will be saved to the site’s Webview and the editor applet will load.  
 
Note if you mistakenly clicked “Next” and were directed to the Linking Web Pages screen, please 
ignore and click ‘OK’ or ‘Finish & Edit’ button. 
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EDITING AN EXISTING PAGE 
 
To edit a page through Site Studio, do the following: 
 
• If you have not already done so, open your Internet browser, enter the URL for 

the machine upon which the Site Studio is hosted. 
 
• From the login menu, click the Site Studio Entry Point, enter your login name 

and password, and click Login. 
You see the Site Studio application presenting four tabs: My Sites, Inbox, My Files, 
and Subscriptions. 
 

• If not already selected, click the My Sites tab. 
You see a list of the sites for which you have access. 
 

• Using the tools provided to page through the display list, locate the site containing 
the content file that you want to edit. 
 

• From the list of Webviews displayed for the site, click the Webview that contains 
the content file. 
You see a list of folders and files contained in the Webview similar to the following 
that constitutes content that is published for the site: 

 

 
 
• To modify a Webpage, locate the options to the right of the file name and click 

Edit: 
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The page will open through Site Studio with the fields, image options, and HTMLeditor(s) 
defined by the layout that governs it, similar to the following: 

 
  

 
 

• Use the fields and options provided for the page to make changes as appropriate. 
 
When you edit a Webpage managed by Site Studio, the content that you are allowed to add is 
dictated by the layout used to create the page. The layout itself is derived from a content 
template that specifies the areas of the page that are static and those to which users may add 
content. For areas where content may be added, the templates support  three basic options: 
uploadable images, plain text fields, and free-form HTML content 
 
IMAGES 
In areas of pages where you are allowed to add your own images, you will see a data 
entry field and browse button similar to the following: 
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To add an image in these areas use the Browse button to open an applet that you can use to locate 
an image that has been loaded into the Site Studio. 
 
 
TEXT ENTRY 
 
In areas of pages where you’re allowed to enter text you see fields similar to the following: 

 

 
Typically, the fields will be marked to indicate the type of information to include. 

 
 

HTML CONTENT 
 

In areas of pages where you are allowed to enter HTML content, you will see an applet similar to 
the following: 
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To add content in these areas, you use the options provided through the applet that allow you to 
format textual content with HTML tags or to add links, images, tables, or other HTML elements. 
 
The following table illustrates all potential buttons and options that you may be able to work 
with: 
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ion 
Feb 4, 2005 Creating and managing content 4.49 
• When you are finished editing the page, click Save. 
 
• To place your file into a workflow so that it is promoted, click Submit. 

 
Note : It is important to keep in mind that the content items that are inserted into your 
content, such as images, components, files, css files must themselves be promoted and 
activated at the same time; otherwise, these items will not appear with your content on the 
Active Website. 
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VIEWING A PAGE 
 

All the content for a site is maintained in a Webview. Basically, a Webview is a folder where the 
Webpages, images, and supporting files are stored. 
 
To view content you must access a Webview within a site. To do so, use the following procedure: 

 
• If you have not already done so, open your Internet browser, enter the URL for the 

machine upon which the Site Studio is hosted. 
 
• From the login menu, enter your login name and password, click the Site Studio Entry 

Point, and click Login. 
You see the Site Studio application presenting four tabs: My Sites, Inbox, My Files, and 
Subscriptions. 
 

• If not already selected, click the My Sites tab. 
You see a list of the sites for which you have access. 
 

• Using the tools provided to page through the display list, locate the site whose content 
you want to view and click open its folder. 
 
You see a screen similar to the following that illustrates the Webviews, components, and 
subsites available for the site: 

 
 
 

 
 
 
• From the list of Webviews displayed for the site, click the Webview that contains the 

content you want to view. 
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You see a list of folders and files contained in the Webview similar to the following that 
constitutes content that is published for the site: 

 

 
 
 
• To view a content file, click the filename or the View option next to its name.  

If the content that you are viewing is a Webpage, you see it framed within the Site Studio  
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DELETING A PAGE/ WEB CONTENT 
 
There may be times when you need to permanently remove a content item from your site. 
 
• If you have not already done so, open your Internet browser, enter the URL for the 

machine upon which the Site Studio is hosted, and log in. 
 
• From the My Sites tab (Streamline view) click open the site that contains the content 

that you want to delete. 
Note, you can also delete content files through the Classic view. 
 

• Click open the Webview or folder that contains the content. 
 
• From the list that displays, click More next to the file that you want to delete. 

You see a menu providing File, View, Document, and Tools menus: 
 

 
 
 
• Highlight the File menu and select the Delete option that appears. 

You see a Delete screen that allows you to select whether you want the selected version of the 
file to be deleted or all versions. 

 
 
• Click the radio button for the version to delete and click OK. 

If you select All Versions, the current version of the file and all previous versions 
will be deleted. 
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CREATING AND MANAGING COMPONENTS 
 
CREATING NEW COMPONENTS 
 
A component defines content, images, links, or other elements that you want to use globally 
across many site pages or throughout a number of Webviews. 
 
To create a new component, use the following procedure: 
 
 If you have not already done so, open your Internet browser, enter the URL for 

the machine where Site Studio is hosted, and log in. 
Note that you must log in to the system as a user who has the Template Developer or Site 
Manager role for the site for which the component is being created. 
 

 Using the Streamline view, open the site for which you want to create a 
component. 
 

 To create a component for use in a specific Webview, open the 
Site’s Webview folder; otherwise, open the site’s Shared folder. 
 

 From the Folder Actions menu, click New Component. 
You see the New SCT Component screen: 
 
 

 
 
 
 In the Name field, enter a name for your component. 

 
The name can contain letters (a, b, c, etc.), numbers (1, 2, 3, etc.), periods ( . ), 
dashes ( - ), and underscores ( _ ). It cannot contain any other characters or any 
spaces. 
 

 In the Title field, enter an appropriate title for this new component. 
This field is optional and is available for use by the Template Developer and can be 
exposed for use in other areas of the program. 
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 In the Subject field enter an appropriate subject. 
This field is optional and can contain more information than the title field. This field 
can be exposed for use in other areas of the program. 
 

 If necessary use the Keywords field to enter any keywords to index this component for 
searches.  

 
 Set Effective Dates and Expiration Dates as necessary. 

If you do not define an active or expiration date for the component, it will use the default 
expiration defined for the site in which it resides. 
 

 Select the Finish and Edit button to create the component. 
 
If your component is a default XHTML type, a component editor similar to the following 
opens: 

 

 
 
 

You can use the above WYSIWIG features of the editor to create your component or you 
can click the Source View tab and paste properly formatted XHTML code into the applet. 
 
 When you are finished with the component, click the Save button. 

The component will be saved and you will be returned to the file list. 
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EDITING COMPONENTS 
 
Once a component has been created for a site, you can edit it and all layouts and 
Webpages that include it will be updated automatically. To edit a component, use the following 
procedure: 
 
 If you have not already done so, open your Internet browser, enter the URL for 

the machine upon which the Site Studio is hosted, and log in. 
 
Note that you must log in to the system as a user who has the Template Developer 
or Site Manager role for the site for which the component is being used. 
 

 Using the Streamline view, open the site for which you want to modify a 
component. 
 

 Open the Webview or Shared folder that contains the component. 
 
 Click the Edit link next to the component that you want to modify. 

 
The Site Studio component editor applet opens, which allows you to modify the content of 
the component through a WSYIWIG tab or a Source View tab. The WSYIWIG tab allows 
you to adjust content and apply formatting using the editor tool bar buttons. The Source View 
tab allows you to work directly with the component’s XHTML code. 
 

 To exit without changing the component, click Cancel or to save changes 
made to the components click Save. 
 
If you made changes to the component, they will be reflected in any layout or a 
Webpage where the component has been mapped or inserted. 
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DELETING COMPONENTS 
 
 If you have not already done so, open your Internet browser, enter the URL for 

the machine upon which the Site Studio is hosted, and log in. 
 
Note that you must log in to the system as a user who has a System Administrator, 
Template Developer, or Site Manager role for the site for which the component is 
being used. 
 

 Using the Streamline view, open the site for which you want to delete a 
component. 
 

 Open the Webview or Shared folder that contains the component. 
 
• From the list that displays, click More next to the component that you want to delete. 

You see a menu providing File, View, Document, and Tools menus: 
 

 
 
 
• Highlight the File menu and select the Delete option that appears. 

You see a Delete screen that allows you to select whether you want the selected version of the 
component to be deleted or all versions. 

 
 
• Click the radio button for the version to delete and click OK. 

If you select All Versions, the current version of the component and all previous versions 
will be deleted. 
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UPLOADING OR IMPORTING FILES/IMAGES/DOCUMENTS 
 
You can import content elements such as images or supporting files such as Word documents into 
the site. If you want the content that you are importing to be available to other Webviews in your 
site or in other sites, you should import the content into your site’s Shared folder or one of the 
subfolders that may exist under it. To import content elements or other files into the site, use the 
following procedure: 
 
 If you have not already done so, open your Internet browser, enter the URL for the 

machine upon which the Site Studio is hosted, and log in. 
 

 From the My Sites tab (Streamline view) click open the site into which you want to 
import content. 
 

 Click open the Webview or folder into which you want to import files. 
 
 From the Folder Actions menu, select Import. 

You see an Import Files screen similar to the following: 
 
 

 
 
 
 Click the Add Files button to add individual files or the Add Folders button to add the 

entire contents of a folder. 
 
You see a Select Files screen that allows you to browse folders on your computer or an 
accessible network. 
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 If you selected to add files, select those that you want, or if you used the Add Folders 

option, select the appropriate folder and click OK. 
 
All files that you selected (Add Files), or that are included in the folder (Add Folder) will be 
added to the import file screen as illustrated below: 

 

 
 
 
 Click the Next button. 

 
You see an “Import: Object Definition” window similar to the following that lists the name of 
the file being imported, its type, its format, and allows you to set its effective and expiration  
dates. 
 

 
 
 
The Site Studio should set the Type and Format correctly for the file that you are importing. If it 
is unable to do so, you will receive a warning with information about what needs to be set. 
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 Verify the name, type, and format and if necessary, set an Active and Expiration Date 

 If you are importing a single file, click Finish to apply these settings. For multiple file 

You will be returned to the view of the folder where you elected to import. The imported 

 

 
 

for the file by using the date fields. 
 

imports, click Next to define settings for subsequent files. 
 

file(s) will be visible in the folder contents. 
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LOGGING OUT OF SITE STUDIO 
 
When you are finished working in Site Studio, you should exit the application by logging 
out before closing the browser. Logging out ensures that all browser sessions in which you are 
working are terminated and all control objects such as cookies and database connections are 
closed properly.  
 
To log out of the system, use the following procedure: 
 
 Close or finish working in any currently active Site Studio window or form. 

When you are working in a Site Studio form, such as creating a search or adding users, 
the logout functionality is unavailable. 
 

 From the upper right-hand corner of the Site Studio application, locate and click the 
Logout button.  

 
 If you need to log back in, click the link provided; otherwise, you may now close the 

browser. 
 
 
 
 
 


